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1. Introducing RealPublisher
RealPublisher is a powerful tool that makes it possible for you to create
RealAudio and RealVideo presentations. Now you can add the dimensions
of sight and sound to your Web site or e-mail. It’s easy and fun to use
RealPublisher to demonstrate your company’s products, broadcast your CEO’s
speech, or show home videos over the Web or through e-mail.

Your audio and video can be placed on your Web site for on-demand access by
end users, broadcast live over a network, or simultaneously broadcast live and
stored as a file for later use.

RealPublisher is a fast and easy way to put streaming RealAudio and RealVideo
on your Web pages. With RealPublisher you can deliver streaming audio and
video even without a RealServer by streaming from a standard Web server.

1.1. What RealPublisher does

The RealPublisher is the latest tool from RealNetworks to enable streaming
media, allowing audio or video clips to play as soon as they are received by
your computer and eliminating the wait for file downloads.

RealPublisher allows you to:

• create RealMedia files

• automatically create RealMedia-enabled Web pages

• publish your RealMedia-enabled Web pages to Web servers or RealServers

• send your RealMedia files via e-mail



Getting Started with RealPublisher

2

1.2. Basic steps to adding streaming
media to your Web site

1. Select audio and video content from a variety of sources:

• existing audio and video files, including .wav, .avi, .au, and .mov file
formats

• media devices such as video cameras, microphones, audio tape,
videotape, and satellite feeds

2. Record your source audio and video to create RealAudio and RealVideo
files in several ways with:

• wizards that automatically set audio and video bandwidth options for
the connection delivering your content

• pre-defined recording templates

• or your own customized recording templates

3. Create Web pages that:

• are linked to your RealAudio and RealVideo files and launch the
RealPlayer

• or have the RealPlayer embedded within the page

4. Publish your RealMedia Web pages:

• to a Web server

• to a RealServer

• or via e-mail
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1.3. About RealAudio and RealVideo

RealPublisher creates on-demand content that users can access whenever they
choose and can be created in all screen sizes. It can be played from standard
Web servers or from a RealNetworks RealServer for higher reliability. Live
audio and video require a RealServer.

With RealPublisher you can choose to deliver a wide range of media quality
and performance, from ordinary modem connections all the way to corporate
LANs. You can also maximize the available bandwidth to meet the demands of
the content, for example, a music video requires different emphasis than a
simple speech.

1.4. About this guide

Chapter 1 introduces RealPublisher, explains what it does, and outlines the
basic steps for adding streaming media to your Web site.

Chapter 2 explains installation procedures and provides information about
system requirements for installing and using RealPublisher.

Chapter 3 explains bandwidth, recording existing files, recording from media
devices, live broadcasting, and using Advanced Mode.

Chapter 4 discusses how to generate RealMedia-enabled Web pages, publish
those Web pages to a server, and send RealMedia files via e-mail.

Chapter 5 provides tips for enhancing RealPublisher’s performance,
customizing recording templates, creating bandwidth-negotiated files, altering
image size, controlling volume, monitoring audio levels and encoding statistics,
and editing your media files.
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1.5. For more information

For more information about any of the topics in this manual, refer to the
RealAudio and RealVideo Content Creation Guide, available at RealNetworks
Web site at www.real.com.

Other topics included in the RealAudio and RealVideo Content Creation Guide
are:

• RealPublisher installed files and file extensions

• command-line encoding

• editing RealAudio and RealVideo

• synchronized multimedia

• simulating a live broadcast

• image maps

• command-line editing

• configuring your Web site
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2. Installing RealPublisher
Installing RealPublisher is quick and easy. You can download RealPublisher
from the RealNetworks Web site or install it from a CD-ROM. Before you
begin, make sure your computer conforms with the necessary system
requirements. See “System Requirements” below for more information.

To download and install the program from the RealNetworks Web site:

1. After purchasing the product online, click the Save to Disk button and
specify a temporary directory for the installation program. Note where you
saved it.

2. In File Manager or Explorer, double-click the installation icon in the
temporary directory to activate the automated installation process.

To install RealPublisher setup program from CD-ROM:

1. Insert the CD-ROM into the drive.

2. Follow the prompts.

To complete the installation of RealPublisher:

1. Close any other applications that may be open and click Next.

2. To accept the terms and conditions for installing RealPublisher, click
Accept.

3. Enter your name, company or organization name, and e-mail address.
Then click Next.

4. Enter the serial number you received when you purchased RealPublisher,
and click Next.

5. When prompted, select your Internet Service Provider. Select Generic−−No
Defaults if your Internet Service Provider is not listed. Then click Next.

6. To install RealPublisher into the default directory, click Next. If you wish
to install RealPublisher in a different location, click Browse and select the
directory into which you want it to be installed.
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7. To finish the installation, click Finish.

8. Click OK when the installation is completed.

2.1. System Requirements

This section outlines the basic hardware and software requirements needed to
use RealPublisher. Requirements are based upon the source of the recording
(existing files or live capture and recording).

RealPublisher is currently available for the following operating systems:

• Microsoft Windows 95

• Microsoft Windows NT (3.5, 3.51, and 4.0)

2.1.1. Recording existing files to RealAudio or
RealVideo

The following table lists the minimum and the recommended requirements for
recording existing audio and video files into RealMedia files:

Requirement Minimum Recommended

CPU 486/66 DX Pentium 120

RAM 8 MB 16 MB

Hard Disk space
(software)

4 MB

Hard Disk space (data) 500 MB 1 GB

Color Display 16-bit 24-bit (TrueColor)

Sound Card 16-bit sound card or better
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2.1.2. Recording live video to RealAudio or
RealVideo

In addition to normal hardware and software requirements, live capture and
recording can use content from a variety of sources:

• VHS, S-VHS, or Beta-SP tape

• live video camera and microphones

• any other video or audio source

High-quality, live recording takes longer and requires greater computer power
than recording existing files. The following table lists the minimum and
recommended requirements for recording at low and high frame rates.

Requirement Low Frame
Rate (less than
3 fps)

Minimum for
High Frame
Rate (more than
3 fps)

Recommended
for High Frame
Rate or Large
Screen Sizes

Operating System Windows 95 Windows NT

Computer Pentium 166 MHz Pentium 200 MHz Dual Pentium 2

RAM 32 MB 64 MB

Hard Drive 1 GB 1 GB

Color Display 16-bit 24-bit (TrueColor)

Video Capture
Card

Any native Video for
Windows capable
capture card

Osprey 100, Osprey 1000 (or equivalent)

Sound Card 16-bit sound card or
better

16-bit sound card or better

Note: Slower machines also give reasonable results in Slide Show mode, at
1fps or less.
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3. Creating RealAudio and
RealVideo

This chapter describes how to use RealPublisher to convert your media into
RealAudio and RealVideo. It provides instructions for recording existing media
files, for recording from media devices, and for broadcasting your live content.

RealPublisher gives you two different methods for recording: Wizard Mode and
Advanced Mode. Wizard Mode is the easiest method; it guides you step-by-step
through the recording process. Advanced Mode is for more knowledgeable
users—those who want to customize the recording process.

You can use RealPublisher in the following ways:

• Recording existing audio and video files

• Recording from media devices

• Broadcasting live content

Before you get started, however, the next section describes the most important
aspect of streaming media files over the Internet or across a corporate LAN:
bandwidth. Learning about and considering bandwidth allows you to get the
most out of your RealMedia Web site.

3.1. About bandwidth

Bandwidth, also known as bit rate, is the amount of data that can be sent
through an Internet or network connection during a set period of time.
Bandwidth is measured in kilobits per second (Kbps). Standard modems are
commonly referred to by the bit-rate they are able to receive, for example, 14.4,
28.8, and 56 Kbps. These designations may already be familiar to you.

In addition to these standard bandwidths, you can record clips for bit-rates up
to 100 Kbps, 200 Kbps, or higher. These higher bandwidths, however, are
generally more typical of corporate LANs or entertainment-based Web sites.
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Keep in mind that the bandwidth a connection is capable of is greater than the
average bandwidth carried across it. For that reason, the templates for 28 Kbps
connections actually only use approximately 20 Kbps, while a 56 Kbps
connection template actually uses about 34 Kbps.

These constraints can affect your recording in many ways. You sometimes have
to compromise between reaching the largest audience (with the lowest-speed
connections) and the quality of your work. Fortunately, RealPublisher comes
equipped with a Recording Wizard that helps you maximize the quality of your
content.

3.2. Recording existing media files

RealAudio and RealVideo clips may be created from previously-captured digital
audio or video files.

The following audio and video formats are supported by RealPublisher. It is
recommended that you use uncompressed files whenever possible:

• Audio (.au)

• Waveform (.wav)

• Uncompressed Video for Windows (.avi)

• Uncompressed QuickTime for Windows (.mov)
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To create RealAudio or RealVideo from an existing file using the Recording
Wizard:

1. Start RealPublisher. If RealPublisher is already open, select New Session
from the File menu.

2. If RealPublisher opens in Advanced Mode, click the Wizard Mode button.

 The New Session dialog box opens:

 

3. Select Record from File and click OK.
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 The Recording Wizard opens:

 

4. Click Next.

5. Use the Browse button to locate the audio or video file that you will use as
the source for your recording.

6. Click Next.

7. Enter the Title, Author, and Copyright information in the provided
spaces.

 This information will appear in the viewer’s RealPlayer when your clip is
played. This step is optional.

8. Click Next.

9. Select the Target Audience—the connection speed for most of your
viewers.

10. Click Next.
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11. Select the type of audio that your file consists of, and click Next.

12. Select the video quality for your output file (if applicable), and click Next.

13. Enter the name and directory of your final, recorded RealMedia file, and
click Next.

14. Review all information regarding your file. If it is correct, click Finish.

 You are returned to the main RealPublisher window:

 

15. Click Start to begin recording.

16. When the recording is completed, click OK to return to the main window.

17. To experience your recording, click Play.

You must have RealPlayer installed to play your recording.
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3.3. Recording audio or video from a
media device

With RealPublisher, you can record RealAudio and RealVideo from many types
of media devices: live microphone input, live video camera input, audio tape,
video tape, or satellite feeds.

You can use either RealPublisher’s Wizard Mode or Advanced Mode to record
RealMedia files.

Before you begin, make sure that your media device is properly connected and
is working correctly.

To create RealAudio or RealVideo from media devices using the Recording
Wizard:

1. Start RealPublisher. If RealPublisher is already open, select New Session
from the File menu.

2. If RealPublisher opens in Advanced Mode, click the Wizard Mode button.
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 The New Session dialog box opens:

 

3. Select Record from Media Device and click OK.

 The Recording Wizard opens.

4. Click Next.

5. Select the Input Source(s): audio or video.

6. If you select a video source, specify whether you are using a video capture
card or a video camera connected directly to your computer’s external port.

7. Click Next.

8. Enter the Title, Author, and Copyright information in the provided
spaces.

 This information will appear in the viewer’s RealPlayer when your clip is
played. This step is optional.

9. Click Next.
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10. Select the Target Audience—the connection speed that you believe your
viewers will have.

11. Click Next.

12. Select the type of audio that your content consists of.

13. Click Next.

14. Select video quality for your output file (if applicable), and click Next.

15. Enter the name and directory of your final, recorded RealMedia file, and
click Next.

16. Review all information regarding your file. If it is correct, click Finish.

 You are returned to the main RealPublisher window:

 

17. Click Start to begin recording.

18. Monitor your live audio and/or video input, and click Stop to finish
recording.
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19. When the recording is completed, click OK to return to the main window.

20. To experience your recording, click Play.

You must have RealPlayer installed to play your recording.

3.4. Broadcasting live content

In addition to creating RealAudio and RealVideo files from your media sources,
you can use RealPublisher to broadcast your live content over the Internet or a
corporate LAN. You must have access to a RealServer in order to use this
feature.

To broadcast live content using the Recording Wizard:

1. Start RealPublisher. If RealPublisher is already open, select New Session
from the File menu.

2. If RealPublisher opens in Advanced Mode, click the Wizard Mode button.
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 The New Session dialog box opens:

 

3. Select Live Broadcast and click OK.

 The Recording Wizard opens.

4. Click Next.

5. Select the Input Source(s): audio or video.

6. If you select a video source, specify whether you are using a video capture
card or a video camera connected directly to your computer’s external port.

7. Click Next.

8. Enter the Title, Author, and Copyright information in the provided
spaces.

 This information will appear in the viewer’s RealPlayer when your clip is
played. This step is optional.

9. Click Next.
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10. Select the Target Audience—the connection speed that you believe your
viewers will have.

11. Click Next.

12. Select the type of audio that your content consists of.

13. Click Next.

14. Select the video quality for your output file (if applicable), and click Next.

15. Enter the name, port, and password of the RealServer that you will use for
your broadcast. Plus, you must enter a filename that users will use to access
the broadcast.

 You may also specify a filename and location for an archive of your
broadcast. Select Archive Broadcast to File, then enter a file name.

16. Click Next.

17. Review all information regarding the broadcast. If it is correct, click
Finish.

 You are returned to the main RealPublisher window.

18. Click Start to begin broadcasting, and click Stop to end it.

3.5. Using Advanced Mode

Advanced Mode allows you to more closely control your recording. Whether
you are recording from a file, recording from media devices, or live
broadcasting, Advanced Mode gives you more control over your output. You
can select the exact recording template, including custom templates. Only
experienced users with advanced knowledge of bandwidth and recording
templates should use Advanced Mode.

This section gives you the basic procedures for using Advanced Mode to record
your content. See the “Tips and Tricks” chapter for more detailed information
about custom templates, bandwidth negotiation, and more.
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To create RealAudio or RealVideo from an existing file using Advanced Mode:

1. From the RealPublisher main window, choose Advanced Mode from the
Options menu.

2. Click New Session from the File menu.

 The New Session dialog opens:

 

3. In the Input Source section, select File.

4. Click the Browse button to locate the audio or video file that you will use
as the source for your recording.

5. In the Output section, select RealMedia File.

6. Click the Save As button to choose a directory and filename for the
recorded file.

7. Click Save.

8. Click OK.
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 The New Session dialog closes, returning to the RealPublisher main
window:

 

9. Enter the Title, Author, and Copyright information for your output file.
These fields are optional.

10. Select Mobile Download if you wish to create content that can be
downloaded by a RealPlayer and transferred to Mobile Players such as the
Audible Player for deferred playback.

11. Select Selective Recording if you wish users to be able to save your
RealVideo or RealAudio file to their computer.

12. In the Recording Templates list box, select the template for the target
audience you want to encode your file for.

 You may select more than one template, see “Multiple-template recording”
below for more information.

13. Click Start to begin the recording process.
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 When recording is complete, a message appears indicating the actual bit
rate of the RealMedia file.

 If RealPublisher is unable to record the file at the selected bit rate, you may
need to re-record the file with a different template.

To create RealAudio or RealVideo from a media device using Advanced Mode:

1. From the RealPublisher main window, choose Advanced Mode from the
Options menu.

2. Click New Session from the File menu.

 The New Session dialog opens:

 

3. In the Input Source section, select Media Device

4. Select the media devices that you will record from: audio and/or video.

5. If you select a video source, specify whether you are using a video capture
card or a video camera connected directly to your computer’s external port.

6. In the Output section, select RealMedia File.
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7. Click the Save As button to choose a directory and filename for the
recorded file.

8. Click Save.

9. Click OK.

 The New Session dialog closes, returning to the RealPublisher main
window.

10. Enter the Title, Author, and Copyright information for your output file.
This step is optional.

11. Select Mobile Download if you wish to create content that can be
downloaded by a RealPlayer and transferred to Mobile Players such as the
Audible Player for deferred playback.

12. Select Selective Recording if you wish users to be able to save your
RealVideo or RealAudio file to their computer.

13. In the Recording Templates list box, select the template for the target
audience you want to encode your file for.

14. Click Start to begin the recording process.

 When recording is complete, a message appears indicating the actual bit
rate of the RealMedia file.

 If RealPublisher is unable to record the file at the selected bit rate, you may
need to re-record the file with a different template.

15. Click OK to close the encoding complete message.

To broadcast live content using Advanced Mode:

1. From the RealPublisher main window, choose Advanced Mode from the
Options menu.
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2. Click New Session from the File menu.

 The New Session dialog opens:

 

3. In the Input Source section, select Media Device.

4. Select the media device(s) that you will broadcast from: audio and/or video.

5. If you select a video source, specify whether you are using a video capture
card or a video camera connected directly to your computer’s external port.

6. In the Output section, select Live Broadcast.

7. Enter the name, port, and password of the RealServer that you will use for
your broadcast. Plus, you must enter a filename that users will use to access
the broadcast.

 You may also specify a filename and location for an archive of your
broadcast. Select Archive Broadcast to File, then enter a file name.

8. Click OK.
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 The New Session dialog closes, returning to the RealPublisher main
window.

9. Enter the Title, Author, and Copyright information. This step is optional.

10. Select Mobile Download if you wish to create content that can be
downloaded by a RealPlayer and transferred to Mobile Players such as the
Audible Player for deferred playback.

11. Select Selective Recording if you wish users to be able to save your
broadcast to their computer.

12. In the Recording Templates list box, select the template for the target
audience you want to broadcast for.

13. Click Start to begin broadcasting, and click Stop to end the broadcast.

 When your broadcast is complete, a message appears indicating the actual
bit rate of the RealMedia file.

14. Click OK to close the encoding complete message.
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4. Publishing to the Internet
Along with its powerful RealAudio and RealVideo recording features,
RealPublisher allows you to publish your streaming content to the Internet. You
can:

• automatically create a Web page with RealAudio or RealVideo

• upload a Web page to either a standard HTTP Web server or a
RealNetworks RealServer

• send RealMedia files via e-mail

4.1. Creating Web pages

A primary feature of RealPublisher is the Web Page Wizard. With the Web
Page Wizard, you can automatically create a Web page that contains your
recorded RealMedia file and play back the media file through any Web
browser.

The wizard leads you a series of prompts to help you create the Web page and
choose how it will stream your RealMedia file: either with a RealPlayer in a
separate window, or with a RealPlayer embedded within the page. The wizard
then allows you to preview the finished page with your Web browser and
RealPlayer.

To create a Web page with a Pop-up RealPlayer:

1. Select Create Web Page from the Tools menu.

 The Web Page Wizard opens.

2. Click Next to begin the Wizard.

3. Select a file name.

 The name of the last RealMedia file created by RealPublisher appears by
default. Click the Browse button to locate another RealMedia file.
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4. If you are using Advanced Mode, you can create a Web page for
bandwidth-negotiated files by choosing Bandwidth Negotiation and
locating the directory where the files are located.

5. Click Next.

 The Playback Method page appears.

6. Choose Pop-Up Player and click Next.

 The Web Page Caption page opens. This name will appear in the Web
page as a link to the Pop-up RealPlayer.

7. Enter the caption name and click Next.

 The Web Page Filename page opens.

8. Enter the name and directory of the Web page you want to create and click
Next.

Note: avoid choosing your computer's temporary directory (such as
C:\TEMP) to save your files into.

 The Web page is created in the specified directory, with an associated
metafile containing information about your media file.

9. If you wish to preview your Web page with a browser, click Preview on the
Results page.

You must have RealPlayer installed to view your page properly.

10. When preview is completed, click Finish.

To create a Web page with an embedded RealPlayer:

1. Select Create Web Page from the Tools menu.

 The Web Page Wizard opens.

2. Click Next to begin the Wizard.

3. Select a file name.
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 The name of the last RealMedia file created by RealPublisher appears by
default. Click the Browse button to locate another RealMedia file.

4. If you are using Advanced Mode, you can create a Web page for
bandwidth-negotiated files by choosing Bandwidth Negotiation and
locating the directory where the files are located.

5. Click Next.

 The Playback Method page appears.

6. Click Embedded RealPlayer and click Next.

 The Player Control Layout page appears. In this page, you can decide what
components of the RealPlayer to embed within the Web page.

7. Choose a layout from the available templates.

A preview of the selected layout appears.

8. Select Auto Start if you wish the RealAudio or RealVideo file to play
automatically when the Web page is displayed.

9. Click Next.

 The Web Page Caption page appears. This name will appear as a title for
the embedded RealPlayer controls.

10. Enter a caption name and select either Place Caption Above Embedded
Player button or Place Caption Below Embedded Player.

11. Click Next.

 The Filename page appears.

12. Enter the name and directory of the Web page you want to create and click
Next.

Note: avoid choosing your computer's temporary directory (such as
C:\TEMP) to save your files into.

 The Web page is created in the specified directory, with an associated
metafile containing information about your media file.
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13. If you wish to preview your Web page with a browser, click Preview on the
Results page.

You must have RealPlayer installed to view your page properly.

14. When preview is completed, click Finish.

 Note: Keep in mind that the Web pages you create with the Web Page
Wizard will initially point to media files located on your local hard drive.
When you upload your pages to a remote Web server, these local file
references will automatically be updated. You should avoid making manual
changes to any HTML files created by the wizard. Alterations to these files
or any file references contained in the associated .ram/.rpm metafile may
cause errors when publishing Web pages to a remote server.

4.1.1. About metafiles

A metafile connects a Web page to one or more RealAudio or RealVideo clips
located on a remote server. The function of a metafile is to point to the location
where your media file actually resides and is required for your file to stream,
rather than simply download and play. Typically, a metafile is located on a
server and contains the URL where the RealAudio or RealVideo clips can be
found.

Metafiles created by the RealPublisher Web Page Wizard reside on your local
hard drive and point to files on your local file system. When you publish your
files to a server, the metafiles are automatically updated to include information
about the server where your media files are sent.
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4.2. Publishing your files to a server

Another primary feature of RealPublisher is the Publish to Server Wizard. This
wizard allows you to publish your RealAudio and RealVideo-enabled Web page
to a remote server. The server can be either a RealNetworks RealServer or a
standard HTTP Web server.

The wizard leads you through a series of prompts to help you specify the type of
server and the directory where you will upload your page. You can also specify
the name of the Web server and the URL path where your Web page will be
located. The wizard then allows you to preview the finished page.

Remember that when you upload your Web pages to a remote server,
RealPublisher automatically updates your Web page and .ram/.rpm metafile to
point to the appropriate server addresses, directories and files.

To avoid confusion during the publishing process, two worksheets have been
provided for you: one for simple HTTP streaming and the other for streaming
your media files from a RealServer. You should complete the appropriate
worksheet before you begin.
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4.2.1. Publishing a file to stream from a standard
HTTP Web server

If you are using a standard HTTP Web server to stream RealAudio or
RealVideo, you should obtain the following information from your system
administrator or ISP. For simple HTTP streaming, your Web page and media
file will be copied to the same location.

Worksheet 1: Publishing to an HTTP server

1. File Server: Name or IP address of the file server where your Web page
will be uploaded. For example: ftp.server.com.
______________________________

2. Directory: Name of the directory on the file server where your Web page
will be uploaded. For example, if the personal directory assigned to you by
your system administrator is htmlpages, enter HTMLPAGES as the directory
name. This may be left blank.
_____________________________________

3. Web Server: Name or IP address of the Web server users will use to
locate your Web page.  For example, if the full URL users will use is
http://www.server.com/htmlpages/file.htm, enter WWW.SERVER.COM as the
Web server name.
_______________________________________________

4. URL Path: The URL path on the Web server that users will use to locate
your Web page. For example, if the full URL is
http://www.server.com/htmlpages/file.htm, enter HTMLPAGES as the URL
path.
________________________________________________
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The following publishing instructions (both standard HTTP Web server and
RealServer) are for users who selected the Generic - No Defaults setting when
installing RealPublisher. Otherwise, if you selected a specific Internet Service
Provider during installation, you should follow the simple steps provided by the
Publish to Server Wizard. You may choose a service provider from the
publishing wizard other that what was chosen during installation.

To publish a file to stream directly from a standard HTTP Web server:

1. Click the Publish Web Page button.

 The Publishing Wizard opens.

2. Click Next to begin.

3. Enter the name of the file you wish to publish and click Next.

 The Publishing Profile page opens.

4. Choose an Internet Service Provider from the list or select Generic - No
Defaults if your Service Provider is not listed, and click Next.

 The Streaming Method page opens.

5. Click Stream media clip from a standard Web server and click Next.

 The FTP Server Information page opens.

6. Type in the name or IP address of the FTP server where you are uploading
your files and the directory on the FTP server where your page will be sent.
Then type in your user name and password, and click Next.

 The Web Page URL page opens.

7. Type in the name or IP address of the Web server and URL directory that
users will use to locate your page on the Internet.

8. Click Next.

 The Upload Progress page appears.

9. Click Next to begin uploading your files.



Getting Started with RealPublisher

34

Your files automatically upload to your Web server. If any errors occur
while uploading your files, you will receive and error message describing
the problem and potential solutions.

10. Click View Now! to view your published Web page.

11. Click Finish when you are done viewing your published Web page.

4.2.2. Publishing a file to stream directly from a
RealServer

If you are using a RealServer to stream RealAudio or RealVideo, you will need
to obtain the following information from your system administration or ISP.
Please note that for streaming from a RealServer your Web page will be copied
to a standard HTTP Web server, while your RealMedia file may be copied to a
separate RealServer.
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Worksheet 2: Publishing to a RealServer

1. File Server: Name or IP address of the file server where your Web page
will be uploaded. For example: ftp.server.com.
____________________________

2. Directory: Name of the directory on the file server where your Web page
will be uploaded. For example, if the personal directory assigned to you by
your system administrator is htmlpages, enter HTMLPAGES as the directory
name. This may be left blank.
____________________________________

3. RealServer: Name or IP address of the RealServer where your encoded
media file will be uploaded. For example: ftp.server.com.
_____________________________

4. Media Directory: Name of the media directory on the RealServer where
your RealMedia file will be uploaded. For example, if the media directory
assigned to you by your system administrator is myvideo, you would enter
MYVIDEO as the directory name.
_______________________________

5. RealServer Location: Name or IP address of the RealServer that users
will use to locate your media file. For example, if the full URL users will
use to locate your media file on the Internet is
pnm://pnm.server.com/myvideo/file.rm you would enter PNM.SERVER.COM

as the RealServer name.
_________________________________________

6. URL Path: The URL path on the RealServer that users will use to locate
your media file. For example if the full URL that users will use to locate
your media file is pnm://pnm.server.com/myvideo/file.rm you would enter
MYVIDEO as the URL path.
_________________________________________
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To publish a file to stream directly from a RealNetworks RealServer:

1. Click the Publish Web Page button.

 The Publishing Wizard opens.

2. Click Next to begin.

3. Enter the name of the file you wish to publish and click Next.

 The Publishing Profile page opens.

4. Choose an Internet Service Provider from the list or select Generic - No
Defaults if your Service Provider is not listed, and click Next.

 The Streaming Method page opens.

5. Click Stream media clip from a RealServer and click Next.

 The FTP Server Information page opens.

6. Type in the name or IP address of the FTP server where you are uploading
your files and the directory on the FTP server where your page will be sent.
Then type in your user name and password, and click Next.

 The Web Page URL page opens.

7. Type in the name or IP address of the Web server and URL directory that
users will use to locate your page on the Internet, and click Next.

 The RealServer Information page opens.

8. Enter the name or IP address of the RealServer where your media file will
be sent. Enter the directory where your media file will be sent, plus your
user name and password, and click Next.

 The Media Clip URL page opens.

9. Type in the name or IP address of the RealServer and URL directory that
users will use to locate your media file on the Internet.

10. Click Next to begin uploading your files.
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Your files automatically upload to your Web server. If any errors occur
while uploading your files, you will receive and error message describing
the problem and potential solutions.

11. Click View Now! to view your published Web page.

12. Click Finish when you are done viewing your published Web page.

4.3. Sending your files via e-mail

This section describes how you can send your recorded RealMedia files to other
people using your default e-mail application. Your recipients must have the
RealPlayer installed on their machine in order to play the file.

Your e-mail application must be configured to work with RealPublisher. Refer
to the online Help for more information.

To send your RealMedia file via e-mail:

1. Click the E-Mail Clip button.

 The Select RealMedia File dialog box opens.

2. Browse for the file you want to send, select it, and click on Open.

 A new e-mail message opens with the RealMedia file attached.

3. Specify a recipient, type in a subject, and add any other text, as you would
for a regular e-mail.

4. Send the e-mail.
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5. Tips and Tricks
RealPublisher comes with a variety of options that allow you to create the
highest-quality streaming media.

Because there is no single best process for delivering all types of streaming
audio and video, RealPublisher provides several ways in which you can
customize and streamline your recording.

This chapter discusses how to:

• choose and modify recording templates

• record for multiple bandwidths

• run RealPublisher more efficiently

• produce high-quality audio and video

• alter the image and sound during recording

• monitor the recording process

5.1. Recording templates

This section describes how to choose the recording template that best suits your
needs and how to customize a template if necessary.

The primary reason RealPublisher comes with a variety of templates is that
every audio or video clip has different content and bandwidth considerations.
For example, you would use one template to deliver a speech over a 28.8 Kbps
modem, and another to deliver a music video over an ISDN connection.

Before you begin recording, you must make decisions about the appropriate
settings for different types of audio and video input. RealPublisher supplies
several pre-defined templates to assist users in making those decisions without
having to know how to use the advanced settings. You can also adjust these
templates or define a new template for the type of content you are encoding.
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5.1.1. Pre-defined templates

Each pre-defined recording template is optimized for a particular type of audio
and video content as well as for bandwidth. Select a template that best suits
your needs. RealPublisher also allows you to encode files using more than one
template. See “Multiple-template recording” on page 44 for more information.

It is recommended that if you want to change some of the settings, save the
template as a new template to avoid overwriting the pre-defined template.

The following table lists all templates included with RealPublisher:

Template Name Audio Codec Video Bit
Rate (Kbps)

Total Bit
Rate (Kbps)

Video Frame
Rate

Audio 28.8, Music –
Mono

16 Kbps Music -
High Response

n/a 16 n/a

Audio 28.8, Voice 16 Kbps Voice -
Wideband

n/a 16 n/a

Audio 28.8, Music –
Stereo

20 Kbps Music
Stereo

n/a 20 n/a

Audio 56K Dial-Up
Modem, Music - Mono

32Kbps Music
Mono

n/a 32 n/a

Audio 56K Dial-Up
Modem, Music - Stereo

32 Kbps Music
Stereo

n/a 32 n/a

Audio 56K ISDN,
Music – Mono

40 Kbps Music
Mono

n/a 40 n/a

Audio 56K ISDN,
Music – Stereo

40 Kbps Music -
Stereo

n/a 40 n/a

Audio 112K, Dual
ISDN,  Music - Mono

80 Kbps Music
Mono

n/a 80 n/a

Audio 112K, Dual
ISDN, Music - Stereo

80 Kbps Music -
Stereo

n/a 80 n/a
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Template Name Audio Codec Video Bit
Rate (Kbps)

Total Bit
Rate (Kbps)

Video Frame
Rate

Video 28.8, High
Action

6.5 Kbps Voice 13.5 20 Optimal Sharp

Video 28.8, Slide
Show *

12 Kbps Music 8.0 20 .25 fps

Video 28.8, Talking
Heads

5 Kbps Voice 15 20 Optimal Smooth

Video 56K Dial-Up
Modem, Music

12 Kbps Music 22.0 34 Optimal Smooth

Video 56K Dial-Up
Modem, Voice

6.5 Kbps Voice 27.5 34 Optimal Smooth

Video 56K ISDN,
Music

16 Kbps Music -
High Response

29.0 45 Optimal Smooth

Video 56K ISDN,
Voice

8.5 Kbps Voice 36.5 45 Optimal Smooth

Video 112K Dual
ISDN, Music

16 Kbps Music -
High Response

64.0 80 Optimal Normal

Video 112K Dual
ISDN, Voice

16 Kbps Voice -
Wideband

64.0 80 Optimal Normal

Video High-Bite Rate
200K, Music

16 Kbps Music -
High Response

184.0 200 Optimal Normal

Video High-Bite Rate
200K, Voice

16 Kbps Voice -
Wideband

184.0 200 Optimal Normal

Video High-Bite Rate
300K, Music

16 Kbps Music -
High Response

284.0 300 Optimal Normal

Video High-Bite Rate
300K, Voice

16 Kbps Voice -
Wideband

284.0 300 Optimal Normal

 Note: the total bit rate is a combination of the audio codec and the video
bit rate. The total bit rate for each template is slightly less than the total bit
rate of the bandwidth of the connection.
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5.1.2. Creating new templates

Each template is a mix of various codecs (compression/decompression
algorithms) and settings. Audio-only templates consist of only an audio codec.
Video templates consist of an audio codec, video codec, video bit rate, total bit
rate, frame rate, and recording speed.

The quality of the recorded output is effected by these settings and by the actual
content. Fixed camera shots, amount of motion, and multiple camera shots can
all determine the quality of your output. If one of the pre-defined templates does
not achieve what you are looking for, try creating a new template.

To modify a recording template:

1. Choose Advanced Mode from the Options menu.

2. Select a template from the Recording Templates list and click Settings.

 The Template Settings dialog box opens.

3. Enter the name of the new template in the Template Name field and click
Save.

 Warning: You should always save a template under a new name if you
plan on modifying its settings. Otherwise, you will overwrite the existing
template, deleting it permanently.

4. Select an audio codec. They are arranged by data rate and type of content.

5. Select a Video codec. RealPublisher has two video codecs available, RealVideo
(Standard) and RealVideo (Fractal).

6. Select the total bit rate for the entire encoded file. The video bit rate will be
total bit rate less the audio bit rate.

 Generally, you should reduce the expected total bit rate by 25% to
compensate for connection and packet overhead. For example, choose 20
Kbps for a 28.8 Kbps modem.
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7. Choose a Frame Rate setting:

• Optimized Frame Rate lets RealPublisher automatically adjust the
frame rate according to the content. You can specify whether you want
sharper images, smoother motion, or somewhere in between.

 For example, if you chose Sharpest Image, and a person who is
talking begins to gesture or move around quickly, the frame rate
decreases as the motion speeds up and increases as the motion slows
down. The image sharpness remains constant throughout.

• Fixed Frame Rate gives you the option of forcing the output to
emphasize image clarity or motion smoothness, and is adjusted by
moving the slider.

 For example, if your content contains a lot of motion and you set the
slider closer to the 15 fps setting, the resulting video image will be less
clear but will exhibit smoother motion.

8. Choose an Encoding Speed by moving the slider.

 It is recommended that you leave the slider at Normal Encoding if you are
recording existing files. The faster you encode (record a RealMedia file),
the more your output quality will suffer.

 The encoding speed slider will be disabled if you do not have a recording
session open to record a file. Encoding speed only affects file recording,
and is disabled during live recording.

9. Click Save to save the template with the new settings.

10. Click Close to close the Template Settings dialog.

5.1.3. Creating bandwidth-negotiated files

Bandwidth negotiated files allow you to provide the user with the best quality a
connection can handle without the user having to explicitly choose from
separate clips recorded for different speeds. The process is transparent to users,
and you can configure your site to automatically serve the appropriate file.
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When you create bandwidth negotiated files, you record using multiple
templates and each recorded file is placed in a directory. You then link your
Web page to the directory where the files are located, a RealServer chooses a
file based on the user’s connection speed, and automatically streams the correct
file. You can only use bandwidth negotiation with a RealServer.

To provide content in multiple formats without bandwidth negotiation, your
Web site must have a separate hypertext link and page for each format or
template.

Refer to the RealAudio and RealVideo Content Creation Guide for more
information.

5.1.4. Multiple-template recording

With multiple-templates, you can reach the widest possible audience while still
providing high-bandwidth users with the best listening and viewing experience.
Multiple templates will create several copies of your recording, optimized for
different connection speeds.

For example, you can provide optimal sound for both 28 Kbps and 56 Kbps
connections, and RealPlayer will automatically use the correct stream. The 56
Kbps connection will sound better than the 28 Kbps, because of the higher
bandwidth.

Multiple-template recording is available only using Advanced Mode.

To encode multiple templates:

1. Using Advanced Mode, set up a recording session.

2. Select templates by pressing the Ctrl key and clicking on as many
templates as you need.

3. Click Start.

The Multiple Template Encoding dialog box appears.

Each template should be a different bit rate, for example a 28 Kbps
template, a 56 Kbps template and a 200 Kbps template.
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4. If you are creating bandwidth negotiated files select Bandwidth
Negotiation, otherwise leave this box unselected.

5. Click Begin. The recording process starts.

The Multiple Templates dialog box will remain visible during recording,
and you will be able to monitor audio levels and video output.

6. Click OK when the “Recording Complete” message appears.

7. You will not be able to preview the bandwidth negotiated files until the
directory containing the files is posted on a RealNetworks RealServer. If
you recorded them as individual files, you may now view them with the
RealPlayer.

8. Click Close to close the Multiple Template Encoding dialog.

5.2. Performance improvement tips

RealPublisher has several features that allow you to improve performance and
increase efficiency while recording your media clips.

5.2.1. Disabling viewers

By disabling the input source window, the output source window, and the audio
level meter during live recording, you can increase the frame rate of your
recorded file and decrease the time it takes to record your clip.

To disable viewers during recording:

1. Open the View menu.

 A checkmark is placed next to the viewers that are currently active:

• Input Source

• Encoded Output
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• Audio Meter

2. Select a viewer to disable it.

5.2.2. Live capture-to-file

If you have a real-time capture station, you can use it to capture and compress
directly into RealMedia format. The output of a video player or audio player
can be recorded by RealPublisher to a RealMedia file instead of a Live
Broadcast.

This process eliminates the need to create and store intermediate audio or video
files, which are very large and can take considerable disk space. It is also the
fastest way to capture content like breaking news clips when time-to-post is
important.

5.2.3. Drag-and-drop recording

RealPublisher supports drag-and-drop recording. You must be in Advanced
Mode to use this feature.

To use drag-and-drop with RealPublisher:

1. Click an input file icon and drag it onto an open RealPublisher window.

 This opens a new session with path and file name information entered
appropriately.

2. Enter any descriptive information (title, author, and copyright) and
customize recording settings before clicking Start.

5.3. Producing high-quality audio

This section describes how to successfully create good, quality sound for your
RealAudio or RealVideo clips. Follow these tips in order to get the best quality
from the audio in your recorded files:
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• Use high-quality source files or a recording input device.

• If you are not doing a live broadcast, capture or “digitize” the sound to a
supported file format such as a .wav or .mov whenever possible.

 This allows you to use a sound editor to adjust the amplitude of your signal
to maximize the available dynamic range. If you do not adjust the signal,
the resulting RealMedia file may sound flat.

• If your original audio file signal exceeds the acceptable amplitude range,
the file may be “clipped.” Clipping can give rise to clicks or pops on
playback. If your source file contains a clipped signal, your final
RealMedia file will have high-frequency background noise or static.
Lowering the input volume will help reduce clipping.

• Eliminate any DC offset either while recording or later with an audio
editor. This removes low frequency noise.

• When encoding live-source audio, you have less opportunity to manipulate
your input signal. Be sure that volume levels are prepared and tested before
encoding.

• Cut any unnecessarily long silences from the beginning or end of the
output file to conserve space.

5.3.1. Recording with multiple codecs

Use a CD-quality sampling rate (44.1 kHz), sampling width (16-bit), and two
channels when creating an input file that you intend to record using multiple
audio codecs. Stereo audio codecs will not encode mono audio input, but mono
audio codecs will accept stereo audio input.
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5.3.2. Synchronizing audio and video

The following sampling rates for your source audio will ensure that the audio
remains synchronized with video or other time-critical media. Sampling rates
are lower than the default input rates. For fuller sound, use the higher sampling
rates.

Codec Sampling Rate

14.4 8, 16, or 32 kHz

5 Kbps voice 8, 16, or 32 kHz

6.5 Kbps voice 8, 16, or 32 kHz

8.5 Kbps voice 8, 16, or 32 kHz

15.2 Kbps voice 8, 16, or 32 kHz

16 Kbps voice 16 or 32 kHz

8 Kbps music 8, 16, or 32 kHz

12 Kbps music 8, 16, or 32 kHz

16 Kbps music High response 11.025, 22.05, or 44.1 kHz

16 Kbps music Med response 11.025, 22.05, or 44.1 kHz

16 Kbps music Low response 8, 16, or 32 kHz

20 Kbps music stereo 8, 16, or 32 kHz

40 Kbps music mono 11.025, 22.05, or 44.1 kHz

40 Kbps music stereo 8, 16, or 32 kHz

80 Kbps music mono 11.025, 22.05, or 44.1 kHz

80 Kbps music stereo 8, 16, or 32 kHz
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5.3.3. Using the Audio Level meter

While you record RealAudio or RealVideo clips, you can monitor the Audio
Level to be sure you are encoding the optimal dynamic range. Green indicates a
normal reading. Red warns that you are close to an over-modulated input. The
best sound quality will occur when the top red bar is often lit but the clipping
indicator (the red light above the meter) is never lit.

Clear the clipping indicator during recording by clicking on it. This allows you
to track if audio clipping is occurring without watching the audio level
constantly.

5.3.4. Volume control

While recording, you can adjust or monitor the volume using the Windows
Volume Control window.

To adjust the recording volume:

1. Select Volume Control from the Options menu.

 The Volume Control window opens:
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2. In the Volume Control window, select Properties from the Options menu.

 The Properties window displays:

 

3. Select Recording to adjust the input recording volume. (Playback adjusts
the level of the volume you hear while you are recording, not the volume
RealPublisher uses.)

4. Select from the list of volume controls the type of inputs you will be using
and click OK.
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 The Recording Control window opens:

 

5. Select which recording inputs to use by choosing the Select box for each
input.

6. Adjust the sound level by moving the sliders up or down.

 Remember, if the volume is too high, the recorded sound may be clipped
and appear distorted. If the volume is too low, it will be difficult to hear.
Use the audio level meter in the RealPublisher window to monitor the level
during encoding.

7. Close the Recording Control window and return to the RealPublisher.

5.4. Producing high-quality video

This section describes the type of video input needed to successfully create
quality RealVideo clips. Tips are given for recording existing files and for
recording from external media devices.
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5.4.1. Existing files

In order to get high quality output, your existing files should meet the following
requirements. You can use any size image, but the height and width of the
video will be automatically cropped to a multiple of 16.

AVI files:

• AVI files should have a 24-bit color depth.

• The standard video frame size for the Internet is 176 x 144.

• The file should be uncompressed for best results.

• Indeo drivers must be installed on your machine for the encoder to be able
to open .avi files created with the YUV9 format. The Indeo drivers are
available from the Intel Web site (www.indeo.com). However, if you
captured an AVI file on the same machine as RealPublisher, the encoder
typically has no problem opening it.

QuickTime files:

• 24-bit RGB QuickTime video files

• 8-bit or 16-bit mono and stereo audio

• Files must be uncompressed

5.4.2. External audio and video sources

When using external audio and video sources, you must start with the best
possible quality. In particular, different video formats yield different qualities
when captured (digitized). Additionally, video playback devices commonly
have two types of video outputs, S-video and composite. S-video produces better
results.
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The common video formats in order of quality are:

• Betacam-SP, also known simply as Beta. This format is common among
video production professionals.

• Laserdisc

• S-VHS or Super-VHS

• VHS

5.4.3. Image Size

RealPublisher supports any size image, but will automatically crop the height
and width to multiples of 16. If you use any size image, the video will be
automatically cropped to a multiple of 16.The most common sizes are 176 x
144 pixels or 320 x 240 pixels. An image size of 160 x 120 is also supported.
Live capture image size is controlled through Set Video Format under the
Options menu, and is dependent upon the video capture hardware installed.

5.4.4. Image cropping

The cropping feature allows you to record any section of a video image that you
wish. By cropping an image, you can reduce the overall bitrate of your recorded
clip.

To crop a video image:

1. To edit the image cropping settings, select Crop Settings from the Options
menu.
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 The Image Cropping window displays a sample image from the session
input. Notice the crop lines around part of the image. These lines show the
portion of the image that will be recorded.

 

2. Use Left, Top, Width, and Height buttons to adjust the size and location
of crop lines.

3. Click OK to return to the RealPublisher window.

4. Select Crop Enabled from the Options menu.

5. Click the Start button to start the recording process using the crop settings.

 The cropped image appears in the Encoded Output viewer.

5.5. Monitoring recording statistics

 You can monitor a variety of statistics while your RealAudio or RealVideo clip
records. These include start and stop points, as well as audio and video bit
rates, frame rates, motion quality and encoding speed settings. You can also
monitor the output results of average bit rate, buffer time, frame rate, audio
loss, and duration.
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To monitor recording statistics:

• Choose Statistics from the View menu.

 The Statistics window opens. You can return to the RealPublisher window
without closing the Statistics window.

5.6. Editing your media files

Once created, RealMedia files (.rm) can be edited using the RealMedia Tools
utility (rmtools.exe) installed with RealPublisher. Operations include stream
cutting, copying, and pasting. You can also edit Title, Author, and Copyright
information. Refer to the RealAudio and RealVideo Content Creation Guide for
more information.


